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UTP App Overview

The App Menu and Navigation Bar will be referred to throughout the User Manual.

Web Address & Browsers
To access TaxStream Online and the Uncertain Tax Positions Application (UTP App) enter the
following URL address in your browser: https://www2.taxstreampro.com/corp/ 

The recommended browsers for the UTP App are Microsoft Internet Explorer® 7 or Firefox® 3.
· We highly recommend using Mozilla Firefox.  If you are unable to install this browser, you should

download the Desktop App from the My TaxStream page of the UTP App.  To download the
Desktop App, open up the last news item on the My TaxStream page ("Internet Explorer  6.0
Notice") and follow the instructions provided.

· In Internet Explorer, popups may come up regarding a script on the page.  You should disable
script debugging in Internet Explorer by going to the Tools menu and selecting Internet Options.
 Make sure a check is in the box next to "Disable script debugging (Internet Explorer)."

· If popups continue to appear, refresh the UTP App.
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Log In
In the “LOGIN” dialog box enter your username and password. 
· The username & password are case sensitive.  
· Click LOGIN and you will be directed to the home page of TaxStream Online.

Text Size
The font on the screen can be adjusted to make the text larger or smaller.  To adjust the text size,
choose the View menu option in your web browser, choose “Text Size” and select the size of the font
that you would like to display.

Internet Explorer Mozilla Firefox

Category Setup - Provision Side
An Administrative user is able to define the codes and naming conventions for the Units, Permanent
& Temporary Differences, Tax Adjustments and User Defined States/Jurisdictions needed for the
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UTP App.  Categories are also referred to as components.

Important Note about Categories:  If a category is deleted in the Provision side (Perm Diff, Temp
Diff, or Tax Adj) that is in use by the UTP App (i.e. a position with that code exists in one or more of
your datasets), those associated positions will be deleted from your dataset.  With no category to
reference, the data in the system has nowhere to go.  Please be cautious when deleting categories
in the Provision side!  

**We highly recommend using the Admin Center: Components in the UTP App to manage your
categories.

TaxStream Enterprise Clients
If codes established in TaxStream Enterprise for FAS 109 can be used for your UTPs, they can be
exported, converted and imported into the UTP App.

Export Categories from FAS 109
To export data into a file from TaxStream Enterprise:

· ADMINISTRATION tab > Export Categories
· Enter a file name
· Click Save

Convert the exported file
The export of categories from TaxStream Enterprise will include information that is not necessary
for the UTP App.  The sheets that are used are:

· #CU# Units
· #CPD# Permanent Differences
· #CTD# Temporary Differences
· #CTA# Tax Adjustments
· #CS# States

 
Import converted categories into the UTP App
· On the home screen: Click on Provision > Import/Export Categories > Import Categories
· Import the file into the UTP App:

· Click on Browse
· Select the converted exported file you created
· Click Open & then Submit
· Check for errors in the generated error log

TaxStream Online Clients
If you are a TaxStream Online Client for FAS 109, the permanent differences, temporary differences,
and tax adjustments you have set up for your Provision can also be used in the UTP App.  These
categories will need to be assigned to the UTP App in order for them to appear there.

You can also set up new categories specific to your FIN 48 positions.  See the next section for the
options you have for setting up your categories.
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Non TaxStream Enterprise Clients
If you are not using TaxStream Enterprise or TaxStream Online to complete your FAS 109 provision
you will need to establish the codes and names for the Units, Permanent and Temporary
Differences, Tax Adjustments and user defined States/Jurisdictions.  This can be accomplished by
manually entering the data or via a populated import spreadsheet.

Manual Entry
Categories can now be created and assigned in the Admin Center of the UTP App.  Please refer to
the Components and Unit-Component Assignments section for further information.

Alternately, categories can still be created and assigned in the Provision application of TaxStream
Online.  To access the screens to manually input the categories information click on Provision on
the home page:

Units
· Administration > General > Units > Add New:

· Enter in the required information (see below) and click Save

· If you select USD, EUR or JPY as the currency for the unit (from the final dropdown box above),
the corresponding symbol will display when viewing reports in the UTP App in Local Currency.

Sub-Consolidations
· Administration > General > Sub-Consolidations > Add New:

· Enter a name for the subconsolidation and click Save
· Click on the subconsolidation you just added
· Select the Units you wish to add to the subconsolidation by putting a check in the

checkbox to the left of the Unit code
· Click Save Assignment after you have made your selections

To add all of the component categories click Administration > Unit Attributes

Permanent Differences
· Permanent Differences > Add New
· Click on  Permanent Differences:

· Enter a unique code and the name of the perm diff
· Check the box if you want the permanent difference to be included in the state calculation.

This designation cannot be updated once the unit is populated. 
· Click Save

Temporary Differences
· Temporary Differences > Add New

· Enter a unique code and the name of the temp diff
· Check the box if you want the temporary difference to be included in the state calculation.



UTP App OverviewSOURCE UTP App User Manual 9

© 2009 TaxStream

ONE  

This designation cannot be updated once the unit is populated.
· Click Save

Tax Adjustments
· Tax Adjustments > Add New

· Enter a unique code and the name of the tax adj.
· Click Save

Note: If you are managing your categories from the Provision side, make sure you do not delete the
4 default tax adjustments:

· UTP_I: UTP Interest
· UTP_P: UTP Penalties
· UTP_O1: UTP Other 1
· UTP_O2: UTP Other 2

If you delete any of these tax adjustments and then attempt to add a position in the UTP App
(manually or by import), you will receive an error saying that a duplicate position already exists.

Assignment
After you have created your components, you will need to assign them to the units you have created.

On the home page click Provision > Administration > Assignment > Component - > Unit

· Select the Units you want to assign the components to by putting a check in the checkbox to the
right of the unit Code

· To assign all components in the system to the Unit, put a check in the checkbox to the left of the 
Components header at the top of the list

· To assign select components in the system to the Unit, put a check in the checkbox to the left of
the components

· Click the "+" to the left of a component section to expand and see all the categories
· The components relevant for the UTP App will say "FIN 48" and then the type of component

· After you have made your selections, scroll to the bottom of the page and click Assign

Import Spreadsheet
You can also use an import spreadsheet template to populate your UTP categories.  If you do not
have an Import Categories spreadsheet template, you can export one from the software.
· On the home page click Provision > Import/Export Categories > Export Categories
· Open the generated Excel file

· The spreadsheet template will have multiple sheets each representing a category.  
· The sheets that should be populated for the UTP App are: 

· #CU# Units
· #CPD#  Permanent Differences
· #CTD# Temporary Differences
· #CTA# Tax Adjustments
· #CS# States.

· When you are finished populating the file, be sure to save it.
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· Once you have finished populating your Import Categories spreadsheet you can import it into
TaxStream Online:

· On the home screen: Click on Provision > Import/Export Categories > Import Categories
· Import the file into the UTP App:

· Click on Browse
· Select the converted exported file you created
· Click Open & then Submit
· Check for errors in the generated error log
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App Menu
The App Menu is in the upper left corner of your screen.

Home
Click Home > You will be returned to the home screen.

Contact
Click Contact > A blue popup box will appear with the contact information for the TaxStream
Support Group and the UTP Committee.  

· If you are having trouble with the software and aren't sure how to proceed, call or email the
TaxStream Support Group for guidance.

· If you have suggestions, comments, constructive criticism or new feature/functionality
requests, please feel free to email the UTP Committee.  We will take your feedback into
account when determining the future development of the UTP App.

Help
Click Help > The UTP App User Manual will display for your convenience.

Sign Out
Click Sign Out > You will be signed out of the UTP App and TaxStream Online.

*If you are idle for more than 30 minutes, you will be logged out of the UTP App.  When you attempt
to perform an action after you have been logged out, a warning message will appear letting you
know that you have been logged out.  You will be redirected to the Log In screen after clicking OK.
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Admin Center

The Admin Center section is where Administrator users can manage Users, Datasets, Components
& Assignments, Documentation, Interest & Penalties, FX Rates and Labels.

Some areas of the Admin Center are not yet available.  You will see the following in these areas:

Users & User Assignments
Click the Users tab.

User Admin
After clicking on Users make sure you have selected Users from the Manage drop down

Add a New User
· To create new users, you must contact the TaxStream Support Group.  You will be asked to

provide a written request that states that the user should have the right to access your data. 
Included in the request, please provide the User's Name, Email Address, and what level of
access they should have (Admin, Read/Write, Read Only).

Edit a User
· Double click on the field you wish to edit and make your changes.

· All fields are editable except the User Login field
· Click Save when you are done making changes.

Deactivate a User
· Double click in the Active column for the User you would like to deactivate
· Select "No" from the drop down menu and click Save

**Note: Users can not be deleted - only deactivated.

Cancel Changes
· After editing a user, you may wish to cancel the changes you have made.  This option is available 

before clicking Save.
· Click Cancel > Click OK
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User Rights
After your Users have been created, you may need to change their level of access to your client in
the UTP App.

After clicking on Users make sure you have selected User -> User Type Assignment from the
Manage drop down

User Rights
· Each User can have different rights in the application depending on what activities they will be

required to perform.
· Non Administration – Read Only

· Allows a user to see the data and reports for assigned units and sub-consolidations.
· Non Administration – Read/Write

· Allows a user all the rights of Read Only Users
· Allows a user to enter, modify or delete data in the system

· Administration – Read/Write
· Allows a user all the rights of a Non Administration - Read/Write user
· Allows a user access to the Admin Center

· Allows a user to assign users to units and subconsolidations
· Allows a user to add, change or delete categories

Assign User Rights
· For one user:

· Double click in the User Type column for the User and select the level of user rights the User
should have from the drop down menu

· Click Save when you are done making changes
· For multiple users:

· Hold down Ctrl while selecting the Users you would like to assign user rights to
· Double click in the User Type column for one of the Users you have selected and select the

level of user rights the Users should have from the drop down menu
· Click Save when you are done making changes

**Note: To select all the Users in the table, hold down Shift while clicking on the first and then the
last User in the table.

Edit User Rights
· Double click on the User Type column for the User you wish to edit and select the new level of

user rights the User should have from the drop down menu
· Click Save when you are done making changes.

Cancel Changes
· After editing a User's rights, you may wish to cancel the changes you have made.  This option is

available before clicking Save.
· Click Cancel > Click OK
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User Assignment
After your Users have been created, you may need to adjust their assignments to the Units and
SubConsolidations they should have access to.  When a new user is created it is assigned to all of
your units, but none of your subconsolidations.

Units
After clicking on Users make sure you have selected User -> Unit Assignment from the Manage
drop down
· Click on the magnifying glass for a User to open up the Unit Assignment box
· Select the User(s) you wish to assign to the Units

· To select multiple Users, hold down Ctrl while selecting Users
· To select all Users, hold down Shift while clicking on the first and then the last User in the

table
· Select the units which the Users should have access to in the UTP App by holding down Ctrl while

selecting the Units
· To select all units,  hold down Shift while clicking on the first and then the last unit in the box

· After you have made your selections, click Save Assignments
· A success message will appear: "User successfully assigned" in a yellow box at the top of the

page

Subconsolidations
After clicking on Users make sure you have selected User -> SubConsolidation Assignment from
the Manage drop down
· Click on the magnifying glass for a User to open up the SubConsolidation Assignment box
· Select the User(s) you wish to assign to the Subconsolidations

· To select multiple Users, hold down Ctrl while selecting Users
· To select all Users, hold down Shift while clicking on the first and then the last User in the

table
· Select the subconsolidations which the Users should have access to in the UTP App by holding

down Ctrl while selecting the SubConsolidations
· To select all subconsolidations, hold down Shift while clicking on the first and then the last

unit in the box
· After you have made your selections, click Save Assignments

· A success message will appear: "User successfully assigned" in a yellow box at the top of the
page

View Assignments
· To see what units/subconsolidations are assigned to a User, click the magnifying glass for the

User you are interested in
· The assigned units/subconsolidations will be highlighted in blue

Unassign Components from Users
· Hold down Ctrl while deselecting the units/subconsolidations and then click Save Assignments

Cancel Changes
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· If you accidentally added units/subconsolidations to a user or accidentally removed
units/subconsolidations from a user, you can click the blue Refresh Assignment Selections icon
to revert back to the original assignments.  This option is only available after changes have been
made, but before clicking Save Assignments.

Import
· User assignments can be edited through an import spreadsheet.  Please see Import/Export

Categories for more information.

Components and Unit-Component  Assignments
Click the Components tab

Components
Components are also referred to as Categories in the UTP and Provision Applications.

Important Note about Categories:  If a category is deleted in the Provision side (Perm Diff, Temp
Diff, or Tax Adj) that is in use by the UTP App (i.e. a position with that code exists in one or more of
your datasets), those associated positions will be deleted from your dataset.  With no category to
reference, the data in the system has nowhere to go.  Please be cautious when deleting categories
in the Provision side!  

**We highly recommend using the Admin Center:Components in the UTP App to manage your
categories.

Units
· Choose Units from the Manage drop down menu
· Click Add New

· Enter in the Unit Code & Name and select the Type, Country & Currency from the drop
down menus

· The Country and Currency drop down menus are sorted by Code
· You can type in the country or currency you are looking for in the drop down box to

easily find your selection
· Click Save

· A success message will appear: "Unit successfully created" in a yellow box at the top of
the page

· If you select USD, CAD, EUR, GBP or JPY as the currency for the unit (from the final drop down
box), the corresponding symbol will display when viewing reports in the UTP App in Local
Currency.

States
· Choose States from the Manage drop down menu
· Click Add New

· Enter a unique code and the name of the custom jurisdiction
· Click Save

· A success message will appear: "State successfully created" in a yellow box at the top
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of the page

**Note: Many jurisdictions are in the system by default.  You do not need to create these
jurisdictions:

· United States: The 50 states, AO (All Other), BS (Blended State) and Federal.
· Canada: 13 Provinces (AB - Alberta, BC - British Columbia, MB - Manitoba, NB - New

Brunswick, NL - Newfoundland and Labrador, NT - Northwest Territories, NS - Nova Scotia,
NU - Nunavut, ON - Ontario, PE - Prince Edward Island, QC - Quebec, SK - Saskatchewan, YT -
Yukon) and Canada.

· Other: National

Sub-Consolidations
· Choose SubConsolidations from the Manage drop down menu
· Click Add New

· Enter a name for the subconsolidation and click Save
· A success message will appear: "Subconsolidation successfully created" in a yellow

box at the top of the page
· Click on the subconsolidation you just added and click Assignment Mode

· Select the Units you wish to add to the subconsolidation by holding down Ctrl while
selecting the units

· Click Save Assignments after you have made your selections
· A success message will appear: "Subconsolidation successfully updated" in a yellow

box at the top of the page
· Unassign Units from Subconsolidation

· Hold down Ctrl while deselecting the units and then click Save Assignments
· Cancel Changes

· If you accidentally added a unit to a subconsolidation or accidentally removed units from a
subconsolidation, you can click the blue Refresh Assignment Selections icon to revert
back to the original assignments.  This option is only available after changes have been
made, but before clicking Save Assignments.

· Click on Assignment Mode again in order to leave assignment mode

Permanent Differences
· Choose Permanent Differences from the Manage drop down menu
· Click Add New

· Enter a unique code and the name of the perm diff
· Click Save

· A success message will appear: "Permanent Difference successfully created" in a
yellow box at the top of the page

Temporary Differences
· Choose Temporary Differences from the Manage drop down menu
· Click Add New

· Enter a unique code and the name of the temp diff
· Click Save
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· A success message will appear: "Temporary Difference successfully created" in a
yellow box at the top of the page

Tax Adjustments
· Choose Tax Adjustments from the Manage drop down menu
· Click Add New

· Enter a unique code and the name of the tax adj.
· Click Save

· A success message will appear: "Tax Adjustment successfully created" in a yellow box
at the top of the page

Edit a Component
· Choose the component you wish to edit from the Manage drop down menu
· Double click in the field you would like to edit and make your changes

· All fields are editable except the Code field for Units, Permanent Differences, Temporary
Differences and Tax Adjustments

· Units which are associated with a dataset can not have changes made to the Unit Type,
Country or Currency

· A lock will appear to the left of the Code for these units.
· Click Save when you are done making changes.

Delete a Component
· Choose the component you wish to delete from the Manage drop down menu

· Click on the Unit, SubConsolidation, Permanent Difference, Temporary Difference or Tax
Adjustment you would like to delete and click Delete

· Permanent Differences, Temporary Differences and Tax Adjustments which are in use in
the UTP App can not be deleted

· When you try to delete such a category, an error message will appear: "Could not
delete: *Component Type* is associated with # UTPs"

· Click OK if you are sure you want to permanently delete the selected component

Cancel Changes
· After editing a component, you may wish to cancel the changes you have made.  This option is

available before clicking Save.
· Click Cancel > Click OK

Unit-Component Assignments
After you have created your components, you may need to make changes to the component-unit
assignments.  Permanent Differences, Temporary Differences and Tax Adjustments which are
created are automatically assigned to all of your units.

Assign Components to Units
· Choose the component type you wish to assign to units from the Manage drop down menu

· Permanent Differences, Temporary Differences or Tax Adjustments
· Click on Assignment Mode
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· Click on the unit(s) you wish to assign components to
· If you are assigning components to more than one unit, hold down Ctrl while selecting the

Units
· Select the components you wish to assign to the unit(s) by holding down Ctrl while selecting

the components
· Click Save Assignments after you have made your selections

· A success message will appear: "Components successfully assigned" in a yellow box at the
top of the page

· While in Assignment Mode, you can switch between Permanent Differences, Temporary
Differences or Tax Adjustments to assign them all to your units

· You can also switch to SubConsolidations in order to assign units to your Subconsolidations
· Click on Assignment Mode again in order to leave assignment mode
· While in Assignment Mode you can not Add, Edit or Delete components.

View Assignments
· To see what components are assigned to a unit, click the Unit you are interested in
· The assigned components will be highlighted in blue

Unassign Components from Units
· Hold down Ctrl while deselecting the components and then click Save Assignments

Cancel Changes
· If you accidentally added a component to a unit or accidentally removed components from a unit,

you can click the blue Refresh Assignment Selections icon to revert back to the original
assignments.  This option is only available after changes have been made, but before clicking
Save Assignments.

Import/Export Categories
You can also use an import spreadsheet template to populate your UTP categories.  If you do not
have an Import Categories spreadsheet template, you can export one from the software.
· In the Admin Center click the Components tab and then Export Categories

· Click OK to export your categories with assignments (#CUC# and #CUNC# tabs populated)
· Click Cancel to export your categories without assignments

· Open the generated Excel file
· The spreadsheet template will have multiple sheets each representing a category.  
· All the sheets which are exported apply to the UTP App

· When you are finished populating the file, be sure to save it.

· Once you have finished populating your Import Categories spreadsheet you can import it into the
UTP App:

· In the Admin Center click the Components tab and then Import Categories
· Browse for the file you wish to import, click Open and then Import.
· If the import is successful you will see a yellow Import Status box

· Click Done to return to the UTP App
· If the import is not successful you will see a red Import Status and will be told where errors
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occurred in the file
· Click View Errors to view more detail about the errors in your import file
· Correct your import template and then click Re-Import to import the corrected file

· For detailed information about the columns in the spreadsheet go to the My TaxStream section in
the UTP App.  There is a UTP App Import Categories Guide.

Note: Users are not exported from the UTP App since users cannot be added or edited through the
import spreadsheet at this time.

Datasets and Reporting Datasets
Click the Datasets & Reporting Datasets tab

Datasets
Datasets are the way scenarios are defined in the system.  They can represent any period in time –
month, quarters, year to date, annual, etc.  Datasets can be copied to run multiple scenarios and
rolled over from period to period.

Add a New Dataset
· Click Add New
· Enter a dataset name
· Click the radio button next to No for Read Only.  You will be unable to add to this dataset if you

select Yes.
· Select a fiscal year for the dataset
· Select a fiscal period (FY for full year, Q1 for the first quarter, M1 for January, etc.)
· Choose Empty as the Transaction
· Click Save

Edit a Dataset
· Double click on the field you wish to edit and make your changes.
· Click Save when you are done making changes.

**Editing of datasets which are a part of Sequential Reporting Datasets is not allowed.  These
datasets have a lock to the left of their Dataset Name.

**Editing of datasets which are marked as Read Only is not allowed.  Datasets which are marked as
Read Only have a lock to the left of their Dataset Name and their Read Only (RO?) column will say
Yes.

Delete a Dataset
· Select the dataset you would like to delete
· Click Delete
· Click OK if you are sure you want to permanently delete the selected dataset

Cancel Changes
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· After editing a dataset, you may wish to cancel the changes you have made.  This option is
available before clicking Save.

· Click Cancel > Click OK

Dataset Maintenance
Datasets can be marked as read only to ensure changes aren't made, they can be copied to create
different scenarios and they can be rolled over to the next period.

Read Only Dataset
Lock any datasets that are final to ensure that the data is preserved and not accidentally adjusted. 
The data and related reports in a read only dataset can be viewed, but not modified.  To modify the
dataset, remove the read only designation.
· Double click in the Read Only column of the dataset you wish to mark as Read Only
· Put a check in the Read Only checkbox and click Save
· A lock will display to the left of the Dataset Name to indicate the Dataset is Read Only

Copy a Dataset
· Click Add Dataset
· Fill out the information for the dataset you are creating (refer to Add a New Dataset for help)
· Select Copy as the Transaction and choose the dataset you wish to copy from the drop down

menu below
· Only datasets which have the same fiscal year as your new dataset will be available from the

drop down menu
· Click Save

Rollover a Dataset
· Click Add Dataset
· Fill out the information for the dataset you are creating (refer to Add a New Dataset for help)
· Select Rollover as the Transaction and choose the dataset you wish to rollover from the drop

down menu below
· Only datasets which are from the previous fiscal period will be available from the drop down

menu
· Example:

New Dataset Fiscal Year & Period Datasets available from drop down menu
Full Year - 2007 Full Year - 2006
Quarter 2 - 2008 Quarter 1 - 2008
Month 1 - 2008 Month 12 - 2007

· Datasets with a fiscal period of Year to Date (YTD) can not be rolled over 
· Click Save

Documentation Manager
Click the Documentation Manager tab

The Documentation Manager shows you the attachments you have on your positions in the UTP
App for the current unit you are in, across datasets.  This is a way to see how many items the
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attachment is attached to, as well as how many times the same file appears in the database.  The
"# Items Attached To" and "Actual File Count" may not always be the same number because of the
Create Copy option available when mass adding notes & attachments.

Reload
· If you've added a new attachment and it is not displaying in the Documentation Manager, click

Reload to refresh the table.

Export Selected
· You can export the attachments you have in the UTP App into a zip file by clicking Export

Selected after selecting which attachments you would like to export.

View Document-Position Assignments
· Select desired attachment > Click View Assigned
· The Document-Position Assignment box opens to the right of the Documentation Manager box. 

The box displays the selected attachment name and all positions which have the selected
attachment in the current Unit you are in.  The dataset is the first part of the position description
given.

· Position Description Format: Dataset Name / Position Code / Name / Jurisdiction / Year

Interest and Penalties
Click the Interest & Penalties tab

Interest
· Select Interest from the Manage dropdown
· The interest information for all the positions in the current Unit/Dataset you are looking at will be

in the Interest table
· Positions with Custom Rate Tables

· Positions with custom rate tables have a Calculator icon to the left of the Unit Code.  The start
date in the table is the start date from the first row of the custom table and the end date in the
table is the end date from the last row of the custom table.

· To view the full custom rate table for a position, click the Calculator icon.
· A popup will appear with the full custom rate table including Compounding Option for the

position.

Penalties
· Select Penalties from the Manage dropdown
· The penalty information for all the positions in the current Unit/Dataset you are looking at will be

in the Penalties table

Export Interest & Penalties
· You can export all of the information in the Interest & Penalties tables to Excel

· Click Export Interest & Penalties
· Click OK when prompted

· Your Interest and Penalties information will be on separate tabs in the same Excel workbook
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· Positions which have custom rate tables will have * next to the Start & End dates.

Note:  This information can not be imported back into the UTP App in this format.  This export is for
your records only.

Reload
· If you add a new position, or change any interest and/or penalties information, click Reload to

refresh the table you are viewing

FX Rates
Click the FX Rates tab

Import FX Rates
· Click the Import Rates button
· Browse for the file you wish to import, click Open and then Submit.
· If the import is successful you will see a green flag

· Click Done to return to the UTP App
· If the import is not successful you will see a red flag and will be told where errors occurred in the

file
· Click View Errors to view more detail about the errors in your import file
· Correct your import template and then click Submit again to import the corrected file

**If you attempt to import FX Rates for a dataset which is marked as Read Only you will see the red
flag and the option to View Errors.  The error for this says "Dataset is Read-Only: Dataset Name".  If
this is the only error in your import click Done to return to the UTP App where you will see the other
rates you imported in the FX Rates table.

Export FX Rates
· Click the Export Rates button
· This will export all the units in all datasets that have been created along with their associated FX

Rates.  You will easily be able to make changes in the exported Excel file and re-import the file to
bring those changes into the UTP App.

· Note: Do not make any changes to the "Unit Code" or "Dataset Name" fields in each row of the
Excel sheet.  Changes here will not update the Units and Datasets  in the UTP App and will cause
the import to fail for that row.

Edit FX Rates
· Double click in the field you would like to edit and make your changes

· A red comment marker will appear in the upper left corner of the field if a change has been
made

· Click Save when you are finished making all of your changes
· "All rates successfully updated" message will appear at the top of the screen

**Read Only Datasets can not have their FX Rates edited.  Datasets which are marked as Read Only
will have a lock to the left of the Unit column and edits will not be allowed on those rows in the FX
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Rates table.

Reload FX Rates Table
· Click Reload
· The FX Rates table will refresh

Cancel Changes
· After editing rates, you may wish to 'erase' the changes you have made.  This option is available 

before clicking Save.
· Click Cancel > Click OK

Labels
Click the Labels tab

Label Admin
After clicking on Labels make sure you have selected Labels from the Manage drop down

Add New Label
· Click Add > Type in New Label Name > Click Save
· Note: The preferred format for Label Names is: Label_Name

· Use the underscore "_" rather than create a label which contains a space.

Edit Label
· Double click on desired label name > Make changes > Click Save

Delete Label
· Select desired label > Click Delete > Click OK

Cancel Changes
· After adding or editing a label, you may wish to cancel the changes you have made.  This option is

available before clicking Save.
· Click Cancel > Click OK

View Label-Position Assignments
· Select desired label > Click View Assigned
· The Label-Position Assignment box opens to the right of the Label Manager box.  The box

displays the selected label name and all positions which have been assigned the selected label in
the current Unit/Dataset you are in.

Label Groups
After clicking on Labels make sure you have selected Label Groups from the Manage drop down

Add New Label Group
· Click Add Label Group > Type in New Label Group Name > Click Save
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· Note: The preferred format for Label Group Names is: Label_Group_Name
· Use the underscore "_" rather than create a label group which contains a space.

Edit Label Group
· Double click on desired label group name > Make changes > Click Save

Delete Label Group
· Select desired label group > Click Delete Label Group > Click OK

Cancel Changes
· After adding or editing a label group, you may wish to cancel the changes you have made.  This

option is available before clicking Save.
· Click Cancel > Click OK

Assign Labels to Label Groups
· Click on the label group that you would like to assign labels to and click Assignment Mode

· Select the Labels you wish to add to the Label Group by holding down Ctrl while selecting the
labels

· Click Save Assignments after you have made your selections
· A success message will appear: "Label Group successfully updated" in a yellow box at

the top of the page
· Click on Assignment Mode again in order to leave assignment mode

View Assignments
· To see what labels are assigned to a label group, click the Label Group you are interested in and

click Assignment Mode
· The assigned labels will be highlighted in blue

Unassign Labels from Label Groups
· Click on the label group that you would like to unassign labels from and click Assignment Mode
· Hold down Ctrl while deselecting the labels and then click Save Assignments

Cancel Changes
· If you accidentally added a label to a label group or accidentally removed labels from a label

group, you can click the blue Refresh Assignment Selections icon to revert back to the original
assignments.  This option is only available after changes have been made, but before clicking 
Save Assignments.

Audit Trail
Click Audit Trail
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Settings

Dataset/Unit Select
Once a dataset is created for the UTP App, you will need to set it as the current dataset for it to be
available to be populated with data.
· After clicking on Settings, the box shown below will pop up in the middle of your screen.

  
· Select the Dataset and Unit from the drop down menus that you wish to work with.
· After you have made your selections, click Save
· The Dataset and Unit you have selected will display in the upper right hand corner underneath

the Navigation Bar.  The Dataset Year will also display in parentheses next to the name of the
Dataset.
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My TaxStream

News
This section provides you with important news and updates from TaxStream.  New release notes as
well as any scheduled downtime for software updates will be seen here.  The new Import Template
will also be available in this area as well as the "desktop" version of the UTP App for Internet
Explorer 6.0 users.

The News section defaults to show the top 3 stories, but each news item can be hidden or shown by
clicking the title or the green arrow to the left of the title.

Quick Links
Import
Import your UTPs into the application.  For more information on importing, please see the Import
section.

Export
Export UTP items, UTP Categories or UTP Numbers from the application.  For more information on
exporting, please see the Export section.

Batch Print
Batch Print the main reports from the application into PDF or XLS files.  For more information on
batch printing, please see the Batch Print Reports section.

Dataset Merge
Merge multiple datasets to create a Full Year (or other time period) dataset.  In order to create a
merged dataset, you will need to create a sequential reporting dataset which includes the datasets
you would like to include in the merged dataset.  For further instructions regarding the dataset
merge please click Help in the Dataset Merge window.  See Dataset Merge Approach for more
information regarding your merged dataset.
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· Steps for "In the Provision Administration"
· On the Home Page, click Provision
· In the Navigator, click Administration > General > Reporting Datasets
· Click Add New

· Enter in a name for your Reporting Dataset and choose Sequential as the Type Id from
the dropdown menu

· Click Save
· Click on the name of the new Reporting Dataset you just created

· A list of all your datasets will appear under Assign Datasets
· Put a check in the box next to the datasets you wish to add to the Reporting Dataset and

click Save Assignment
· Sequential reporting datasets are used to combine datasets from continuous periods.
· For Sequential Reporting Datasets, the ending balances from the first dataset must tie

exactly to the beginning balances from the subsequent dataset.
· **Note: The datasets must be added to the Sequential Reporting Dataset in the

correct order or not all of the datasets will be properly added
· Ex: Assign Q1 Dataset, Save Assignment; Assign Q2 Dataset, Save Assignment,

etc.
· If your datasets appear in the Assign Datasets list in the correct order (Q1, Q2, Q3,

Q4) you can check them all off at once and click Save Assignment
· The datasets which are assigned to your Sequential Reporting Dataset will appear at the

top of the Assign Datasets list and will be highlighted blue
· Return to the UTP App to continue the Dataset Merge process
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Dataset Merge Approach
Dataset Merge allows you to take data from multiple single period datasets to create a year to date

dataset for disclosure purposes.
· The beginning and ending balances of the single period dataset must flow from period to

period.  Datasets created using the rollover functionality (i.e. Q1 into Q2 into Q3, etc.) will
ensure that the ending balances from the first period will agree to the beginning balances in
the next sequential period.  

· A Sequential Reporting Dataset is created and the single periods are associated with one
another by sequentially adding each dataset to the reporting dataset.
o Set one of the “to-be-merged” datasets as your current dataset in order for the Dataset

Merge to be successful.

The Dataset Merge creates the year to date dataset when it is selected in the UTP App.  
· Click on My TaxStream on the Navigation Bar.  Click the Dataset Merge option under Quick

Links.
· A dialog box will ask you to choose the reporting dataset and the period of the merged

dataset.  You will also be able to enter the Weighted Average Rate and a name for your
Merged Dataset.  Click Merge.

· Once the datasets have merged successfully, set the Merged Dataset as your current
dataset.

Merged Dataset Results
· All positions entered in these single period datasets will be seen in the reports
· Beginning balances will come from the first dataset

· Beginning (spot) FX Rates come from the first dataset
· The NCS/EQ determination (prior) will come from the first dataset

· Ending balances will come from the last dataset in which a position was active
· Ending (spot) FX Rates come from the last dataset
· The NCS/EQ determination (current) will come from the last dataset in which a position

was active
· No distinction is being made as to when a position was finalized - the reports will not display

that a position was settled in Q2 as opposed to Q3
· All notes & attachments added throughout the position's life will be viewable in the merged

dataset.
· Label assignments and the positions’ status come from the last dataset in which a position

was active
· Footnotes on reports come from the last dataset

Note regarding FX Rates: The Weighted Average rate which is entered when the merge is done is
initially applied to all units in your merged dataset.  After you have your merged dataset you will
be able to make adjustments to your FX Rates across all your units.  Please refer to Admin
Center: FX Rates for more information on updating your FX rates across all your units.

Note regarding NCS/EQ Determination: If a position is NCS in the first dataset and EQ in the last
dataset (or vice versa), the position's current designation will switch to the prior during the
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merge.  (i.e. If the position is NCS (prior) and EQ (current), the position will come into the
merged dataset as NCS (prior) and NCS (current).)  The UTP App does not support the
movement from NCS to EQ or EQ to NCS.

Note: If there is a subsequent change to any of the underlying datasets in the original reporting
dataset, then the Dataset Merge needs to be redone in order to view the effect of the change in
a new Merged Dataset.

Guides
Documentation regarding the functionality of the UTP App can be found in this area.

· Quick Start Guide
· Initial set up of and navigation through the UTP App.

· Calc Functionality Guide
· Examples of entering positions into the UTP App.

· Perm Diff Example
· Temp Diff Example
· State Nexus Example

· Import Template Guide
· Detail about the Import Template columns and how to import into the UTP App.

· Import Categories Guide
· Detail about the Import Categories columns and how to import into the UTP App.

· Settlement Guide
· Detail about the Full & Partial Settlement workflows and examples.

Calcs
Explanations of the calculations in the UTP App can be found in this area.  We will be adding more
to this section as it becomes necessary.

· Item Inventory Calculations
· All of the calculations on the item inventory report are listed here for the various views.

· Currency Translation Adjustment (CTA) Explanation
· An explanation of the CTA calculations used in the UTP App.

Known Issues
A list of known issues in the UTP App along with suggested alternative solutions (if available) and
expected resolution dates (if available).
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Uncertain Positions

The Uncertain Positions section is a unit level summary of all the positions entered for that unit in
the current dataset.  From the Contingencies Table a user can view and manage all the positions for
a unit.  This section allows a user to enter or modify positions and add or view supporting
documentation for a position.

Note: The number of rows in the Contingencies Table is displayed in the lower left of the table.

The dropdown menu to the right of your screen in the Uncertain Positions section constitutes the 
Main Contingency Menu in this area.

 

Add a New Position
· Click on the Main Contingency Menu dropdown
· Click Add New Position
· The work flow to add a new position will begin.
· Step 1: Select the Type of Issue you are entering.  The selection you make here will determine the

information required during the work flow.  Click Next after you have made your selection.

 
· Step 2: You will be identifying the position you are adding.



Uncertain PositionsSOURCE UTP App User Manual 31

© 2009 TaxStream

ONE  

· Select the Code + Name of the UTP you are adding from the first drop down menu.
· Select the Year in which the issue arose.
· Select the Jurisdiction the position falls into.  The selection you make here will also determine

the information required during the work flow.
· If the Jurisdiction menu is not loading when you click on the dropdown, click the green

refresh icon to the left of the menu.
· Note: The country of the unit you are in will determine the Federal/National jurisdiction

option available.
· i.e.: United States - Federal; Canada - Canada; Other (including Undetermined) -

National
· Select the Classification (STAT to TAX or GAAP to TAX) - This selection will have no impact on

any calculations or reports.
· We recommend using this as a way to create a duplicate position.

· Select whether the position should be marked as Non-Cash, Equity or None.  For more
information on this please see the Non-Cash and Equity section.

· If you have selected Temporary Difference as the Type of Issue you will also choose the
Deferred Category (C or NC) the position should be in on this screen.

· Click Next when you have finished making your selections on this screen.

· Step 3: You will be inputting the As Filed information pertaining to the Amount in Question (AIQ).
· Choose the Resolved In Quarter & Year from the drop down menus.

· The Resolved in Quarter & Year will be used to determine whether the related Taxes
Payable should be classified as Current or Non-Current.  UTP App compares the dataset
year with the resolved in year and if that is 12 months or less, the Taxes Payable will be
Current.

· You now have the option of choosing N/A for the Resolved in Year.  Positions with a
Resolved in Year of N/A will display as Non-Current on the Payable Report and in the
Payable sections of the Journal Entry Report.

· Choose the Statute of Limitations Quarter & Year from the drop down menus.
· You now have the option of choosing N/A for the Statute of Limitations Year.

· Enter in the AIQ as a negative number if it was a decrease to taxable income when it was
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originally taken on the return/provision.
· Depending on the Type of Issue and the Jurisdiction you have selected, different Tax Rate

fields will display.  Enter in the requested rates.
· The rates you enter here, on the Issue Details - As Filed screen, will default to the Issue

Details - Unrecognized Position screen.
· Click Next when you are done.

· Step 4a: For Permanent Differences and Tax Adjustments, you have to make the More Likely than
Not determination.

· Make a selection and click Next
· If you choose No - The Amount Expected to be Sustained (AETBS) will be set to zero and

the probability table will not display.
· If you choose Yes - The Probability Table screen will display.

· Step 4b: After selecting Yes, the following screen will display.
· Clicking recalculate will populate the Amount Sustained Current column with 1/8th

increments of the total Amount in Question.
· The incremental amounts in buckets 2 - 8 can be edited as needed, as long as they are in

descending order!
· Assign a percentage, not to exceed 100% cumulatively, for each threshold level of the Amount
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Sustained Current.
· When the cumulative probability is 51% or greater, the corresponding amount in the Amount

Sustained Current column will be the AETBS.
· Click Next when your cumulative probability equals 100%

· Step 5: You will be inputting the information for the Amount Expected to be Sustained.
· For Permanent Differences and Tax Adjustments the AETBS will be populated by what you

entered in the Probability Table.  You will not be able to edit this amount on this screen.  If you
want to make a change to the AETBS click the Back button to return to the Probability Table.

· For Temporary Differences the AETBS will need to be entered into this field.
· Depending on the Type of Issue and the Jurisdiction you have selected, different Tax Rate

fields will display.  Enter in the requested rates.
· These rate fields will be filled in with the rates you entered on the Issue Details - As Filed

screen.  They are editable fields.
· Click Next when you are done.
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· Step 6: You will be inputting additional information about the position.
· Interest & Penalties

· Interest and Penalties can be calculated offline or can be calculated using TimeValue
TaxInterest.  For more information, please see the Interest & Penalties section.

· Enter in the Fed and State Tax Rates for the interest amount to ensure that the benefit is
calculated correctly if you follow a Below the Line treatment of interest and penalties.

· Other Tax Adjustments
· Tax Adjustments can be added to issues to increase or decrease the total amount to be

provided.  For instance, if the issue was providing for recognition of income and there
would be an offsetting tax credit associated with recognizing that income, then the credit
would be entered here.

Non-Cash and Equity
For Permanent Differences and Tax Adjustments, the first data entry screen in the work flow will
look like the following.  
· You will have the option of marking the position as Equity, Non-Cash, or None (if neither applies)

from the drop down.  
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· Positions marked as Non-Cash will always display as Non-Current on the Payable and Journal
Entry reports.  

· Positions marked as None or Equity will display as Current or Non-Current depending on the
Resolved Quarter/Year and Dataset Period/Year.

For Temporary Differences, the first data entry screen in the work flow will look like the following.  
· You will have the option of marking the position as Equity, Non-Cash, or None (if neither applies)

from the drop down. 
· You also must select for all temporary differences, the Deferred Category the position falls into >

Current or Non-Current.  
· This category will display on the Deferred Report regardless of whether Equity or Non-Cash is

chosen.
· Positions marked as Non-Cash will display as Non-Current on the Payable and Journal Entry

reports.
· Positions marked as None or Equity will display as Current or Non-Current depending on the

Resolved Quarter/Year and Dataset Period/Year.
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Once a position has been rolled over, you have the option to change the Equity/Non-Cash option, if
necessary.
· Positions cannot be changed from EQ to NCS or NCS to EQ.
· The Calculation Support Schedule and the Uncertain Journal Entry & Uncertain Expense Reports

show the reclassification of amounts.

Interest & Penalties
Interest and Penalties can be calculated using TimeValue's TaxInterest software which is embedded
into the UTP App.  Interest can now be calculated for both payments and refunds.  Interest and
Penalties can also be calculated offline and entered into the final data entry screen shown below.  If
you calculate interest and penalties offline, the Report button on this screen will not work and you
will not be able to view the Interest & Penalties schedule for individual items.
· Click I & P Calculator to use TimeValue TaxInterest to calculate your interest and/or penalties.
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· After you calculate your interest and/or penalties you will be returned to this screen.
· Remember to enter in rates for interest to ensure the benefit is correctly calculated if you follow a

Below the Line treatment of interest.

Notes regarding Hot Interest:
· Hot Interest can not be computed on refunds.
· If you are using the Overpayment rate, Hot Interest will not be calculated if you enter in a date.
· When mousing over "Hot Interest" on the I&P Calculator screen:

· "For Large Corporate Underpayments" will display to offer further clarification regarding what
this can be used for.

Note regarding Penalties:
· Penalties can not be computed on refunds.

Federal and International Federal Positions
Federal Positions (Domestic & International)
· Federal Positions will show the following screen when you click I & P Calculator on the final data

entry screen.

Note: After you select Federal or International and click Calculate, the designation you did not pick
will be grayed out.  Please be sure to choose the type of interest you would like to calculate for the
life of the position.
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Select the radio button to the right of Federal if you are calculating Interest and/or Penalties for the
Domestic Federal jurisdiction or Canadian jurisdiction that is pre-defined in the system.  The Federal
entry fields are shown above.
· Put a check in the checkbox to the left of the area(s) you would like to calculate.
· Use the calendar feature to select dates to ensure dates are entered in the correct format (MM/

DD/YYYY)
· After you have entered in the required information, click Calculate to calculate the areas you have

completed.
· You will be brought back to the previous data entry screen and your interest and/or penalties

amounts will be filled in.

Federal Penalties
Penalty 6662: Substantial Understatement of Income Tax
Penalty 6651: Failure to File Return when Due

See Custom Rate Tables for information on the International designation.

State and International Positions
State Positions (Domestic or Canada) and Custom Jurisdictions (Domestic & International)
State Positions and Custom Jurisdictions will show the following screen when you click I & P
Calculator on the final data entry screen.
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Note:  After you select Domestic or International and click Calculate, the designation you did not
pick will be grayed out.  Please be sure to choose the type of interest you would like to calculate for
the life of the position.

Select the radio button to the right of Domestic if you are calculating Interest and/or Penalties for a
Domestic State or Canadian Province that is pre-defined in the system.  The Domestic entry fields
are shown below.
· If you use this screen to calculate Interest for a custom jurisdiction, the rate table will default to

Federal and your interest amount may not be what you expected.  We recommend building a
custom rate table for custom jurisdictions.  Please see below!

· States/Provinces without their own rate tables are defaulted to Federal/Canada.
· States: Maine, Montana, Nevada, South Dakota, Washington and Wyoming
· Provinces: British Columbia, Manitoba, New Brunswick, Newfoundland and Labrador,

Northwest Territories, Nova Scotia, Nunavut, Prince Edward Island, Saskatchewan, Yukon
· Put a check in the checkbox to the left of the area(s) you would like to calculate.
· Use the calendar feature to select dates to ensure dates are entered in the correct format (MM/

DD/YYYY)
· After you have entered in the required information, click Calculate to calculate the areas you have

completed.
· You will be brought back to the previous data entry screen and your interest and/or penalties

amounts will be filled in.

See Custom Rate Tables for information on the International designation.

Custom Rate Tables
Select the radio button to the right of International if you are calculating Interest and/or Penalties
for an International Federal jurisdiction or a Custom Jurisdiction (a custom state or an international
jurisdiction other than Canada).  The International entry fields are shown below.  Since these
custom jurisdictions do not have a rate table in TimeValue's TaxInterest, you are able to build your
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own rate table for the position and choose the type of compounding (Daily, Monthly or Simple)
which should be used to compute interest.
· Put a check in the checkbox to the left of the area(s) you would like to calculate.
· After you have entered in the required information, click Calculate to calculate the areas you have

completed.
· You will be brought back to the previous data entry screen and your interest and/or penalties

amounts will be filled in.

Build a Custom Rate Table
· Enter in start and end dates and enter in the applicable rate for the period you have entered.  Only

valid rates will be accepted:
· Rates are available in .25% increments from 1% up to 25%.
· Rates are available in .50% increments from 25% up to 100%.

· Click Add Another Rate to continue building the rate table over time.
· The start date will be one day after the end date from the previous line and can not be

modified.
· You can enter up to five rows of rates!

· If you would like to remove a row from the rate table, click the X to the right of the line you have
entered.

· Only the last line in the rate table can be removed.

Above/Below the Line
Interest and Penalties on UTP balances can be treated as either Above the Line or Below the Line
depending on the determined accounting method.
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Above the Line
· The interest and penalties calculated on the UTP balances are treated as accrued interest and

accrued penalties.

Below the Line
· The interest and penalties calculated on the UTP balances are treated as an additional tax

expense.
· If you expect to deduct the interest when it is paid, you can provide for the interest net of federal

or state benefit by entering the tax rates in the Fed and State Tax Rate - Interest fields.

Underpayment & Overpayment Rates
Interest can be calculated using either the underpayment rates or the overpayment rates for Federal
and Domestic States.  Underpayment rates are typically higher than overpayment rates.

Underpayment Rates (Default)
· To calculate interest using the underpayment rates: 

· Enter in the Interest Start and End Dates and click Calculate.

Overpayment Rates
· To calculate interest using the overpayment rates:

· Enter in the Interest Start and End Dates, put a check in the Use Overpayment box, and click
Calculate.

Interest and Penalties Calculation Support Schedule
· This schedule will show the wrong signs for the calculated interest amount if:

· You choose to use the Underpayment rate and your Interest Calc On amount is negative
· You choose to use the Overpayment rate and your Interest Calc On amount is positive

· This occurs because in these 2 scenarios, the interest amount TimeValue TaxInterest generates is
the opposite sign of what the interest amount needs to be in the UTP App.

Removing Interest Dates
If you have entered in Interest dates for a position, but would now like to remove them:

· Edit the position to open the position's workflow
· On the I & P Calculator tab delete the Start & End Dates and uncheck the Interest box.
· On the Interest and Penalties tab click Save

Modify a Position
New positions can be modified by choosing Edit as New or you can Remove the position if it was
added incorrectly. Once a position is added or rolled over from a prior period you will be able to
Modify that item in one of seven ways.  The type of modification you choose will determine if the
issue is final and should not be rolled over to the subsequent period.

Note: Only current period amounts and dates can be modified in the work flow.
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To Modify a position:
· Click on the position's Code (blue hyperlink) > click Modify > choose desired Modification option

Non-Final Modifications
Positions which are modified in a non-final way will be rolled over to the subsequent period's
dataset.

Adjust for a change in judgment (CIJ)
· Issue existed in a prior period, but in the current period the outlook for the amount or the rate

differs from the prior period or there is an update to penalties.

Adjust for a change in interest (CII)
· Update to an existing position for a change in accrued interest.

Adjust for return to provision (RTP)
· Issue existed in a prior period, but the amount differs from the prior period because of the impact

of a true-up item or there is an update to interest or penalties.

Enter a Settlement - Partial (SET-NF)
· Partial settlements allow for a portion of a position to be settled, while the remaining balance

continues to be uncertain.
· Select Enter a Settlement from the Modify menu and then click Non-Final when prompted.
· A warning message will come up informing you that positions modified in this way can not be

modified again in the current dataset
· This position can be rolled over to a subsequent period's dataset and you will be able to

modify the position in that dataset.
· Click OK to continue
· Click Next on the Identify the Issue screen

· The Issue Details - As Settled screen will appear
· If you click Save without filling in any of the fields, all the amounts will be marked as NLU

and will display in the appropriate Change column on the reports.  A warning will popup if
this is the case - click OK to continue or Cancel to return to the workflow to make changes.

· Amounts which are entered in the Settlement Outlook column will display in the
Settlement column/row on reports when the appropriate Gross/Benefit Option is chosen

· Amounts which are entered in the Remaining Balance column will display in the Ending
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Balance column/row on reports when the appropriate Gross/Benefit Option is chosen
· Rollover of Partial SET Positions:

· Once the position is rolled over, the workflow will be as populated as possible based on last
known values and the applicable amounts from the Remaining Balance column.

Final Modifications
Positions which are modified in a final way will not be rolled over to the subsequent period's
dataset.

Enter a settlement - Full (SET-F)
· An agreement has been reached on the issue and a settlement has been reached.
· Select Enter a Settlement from the Modify menu and then click Final when prompted.
· A warning message will come up informing you that positions modified in this way can not be

modified again
· Click OK to continue

· Click Next on the Identify the Issue screen
· The Issue Details - As Settled screen will appear

· If you click Save without filling in any of the fields, all the amounts will be marked as NLU
and will display in the appropriate Change column on the reports.  A warning will popup if
this is the case - click OK to continue or Cancel to return to the workflow to make changes.

· Amounts which are entered in the Settlement Outlook column will display in the
Settlement column/row on reports when the appropriate Gross/Benefit Option is chosen

Mark as no longer uncertain (NLU)
· Issue existed in a prior period, however, in the current period it is determined that the UTP is no

longer necessary.  The entire amount provided in the prior period will be reversed in the Change
column to bring the taxes payable to zero.

Write off as expired due to statute (EXP)
· Issue existed in a prior period, however, in the current period it is determined that the UTP is no

longer necessary since the statute of limitations has expired. The entire amount provided in the
prior period will be reversed in the Statute column to bring the taxes payable to zero.

**Note: After a position is marked as SET-F, NLU or EXP you will no longer be able to modify the
position!

Reload Contingencies
· Click on the Main Contingency Menu dropdown
· Click Reload Contingencies  
· The contingencies table, containing a list of all your uncertain positions, will refresh.

Note: If the contingencies table is displaying without scroll bars (if there are more than 13 positions
in the table), reloading the table, sorting or reordering the columns will cause the scroll bars to
appear.
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FX Rates

· The FX Rates for the Unit/Dataset you are in are displayed to the right of your screen, above the
Main Contingency Menu

· To edit the FX Rates, mouse over the rate you wish to modify and type the new rate in
· Once you have finished making your changes, click the Save icon (the blue disk) to the right of the

FX Rates
· If you accidentally changed your rates and would like to revert them back to before you made

changes, click the green Revert Changes arrow to the right of the Save icon
· This option is available before clicking the Save icon.

Action Menu
The Action Menu allows you to manage/edit multiple positions at the same time.  
· To view information about each of the Action Menu options:

· Choose an option from the Select an Action dropdown
· Click the arrow to the right of Go to select the Action Detail option

· To perform an action:
· Select the positions you wish to work with in the Contingencies Table by checking the boxes

next to the position Code
· Choose the action from the Select an Action drop down menu
· Click Go or click the arrow to the right of Go to select the Execute Action option

· You can select all the positions in the Contingencies table by clicking the Select All button at the
bottom left of the table

· You can deselect all the selected positions in the Contingencies table by clicking the Clear
Selected button at the bottom left of the table
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Remove/Mark as NLU

Add Notes/Attachments

The Documentation box will come up if you select this option.  Enter in your note and add your
attachments for the positions you have selected and click Save.  

· Create Copy
· If this option is not selected, a single post will be created and attached to each position.  A

reply to this post on one item will be visible on all other items.
· If this option is selected, a new post will be created for each item.  Replying to a post on one

item will not be added to the post on any other item.
· This is equivalent to adding documentation to positions on an individual basis from the

item's menu.

Assign Labels
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Update Interest End Dates

The Updating Interest End Dates box will come up if you choose this option.  Select the new interest
end date from the calendar for the positions you have selected and click Submit.

Note: After you have updated your Interest End Dates, you will need to Recalculate Interest for
those positions.

Note: Since the status for positions which have been rolled over will change to CII after you update
interest end dates, we recommend updating interest end dates before making any other
modifications to your positions to ensure the correct status displays for all of your positions.

Recalculate Interest

Note: Since the status for positions which have been rolled over will change to CII after you
recalculate interest, we recommend recalculating  interest before making any other modifications to
your positions to ensure the correct status displays for all of your positions.
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Batch Print Schedules

The Batch Print Schedules box will come up if you choose this option.  Make your selections (similar
to the Batch Print Reports box) and click Submit when done.

The naming convention for the Item Schedules when batch printed using the Compressed option is
as follows:
· Report Name_UTP Code_Year Issue Arose_Jurisdiction_Random Number
· Example: CalcSupport_T1000_2001_MA_100916
· The random number is included to ensure no two item schedules are identical.

When the Item Schedules are batch printed to Excel and the Compressed option is not selected, the
report names are shortened, but the rest of the naming convention from above is the same.
· IP = Interest & Penalties Schedule
· DT = Item Detail Schedule
· CT = Calculation Support Schedule

If you choose to batch print the Item Schedules for a large number of positions to Excel and the
Compressed option is not selected, the batch printing will automatically switch to Compressed.  (No
more than 50 tabs will be put into 1 Excel workbook.)
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Expired due to Statute

Individual Item Schedules
Schedules for individual positions can be seen by clicking on the Item's code and choosing which of
the three schedules you wish to view.

Calculation Support
The Calculation Support report displays the components of the calculation to support the UTP in
Local Currency.   The report compares the Expected to be Sustained amount with the Amount in
Question amounts and shows the change in the position for the period.

The Calculation Support report can be accessed from the Contingencies Table or by drilling down
from the Uncertain Deferred Rollforward report, the Uncertain Payable Rollforward report or the
Uncertain Expense Report when those reports are displayed in Local Currency.  When selected, the
report displays in a popup box in the center of the screen.

Note: If the popup box comes up, but the report is not displaying, please refresh the UTP App by
clicking the Refresh or Reload icon in your browser.

Item Detail
Item Detail shows all the entries made for each item entered in the system.  The report details the
entry for amounts; interest, apportionment & tax rates; more likely than not response and other
adjustments on a Prior and Current period basis.  The Deferred Category, for temporary differences,
as well as whether the position is Non-Cash or Equity also displays.

Interest and Penalties
Interest & Penalties Calculation Support displays the TaxInterest report supporting the computation
of interest & penalties that was generated using the TimeValue software in the UTP App.  The report
can also be viewed by clicking the Report button on the final screen of the item entry manual entry
process after you calculate your interest &/or penalties.

Note:  This report will only be available if you have used TimeValue TaxInterest in the UTP App to
calculate your interest &/or penalties!

Documentation
Documentation (Notes &/or Attachments) can be added to positions in the UTP App.

Add Documentation
· Click the gray/yellow note icon or choose Documentation from an item's menu to add notes &/or
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attachments to a position.
· Type your note in the note area and browse to add attachments to the position.
· Click Save when you are done.
· Adding Attachments

· If you add an attachment to a position and do not enter a note, a default note will be
added to the position - "Added Attachment".

· Attachment file names should be unique
· The UTP App does not distinguish between different files with the same name

· This only applies for different files of the same type - i.e. multiple excel files
containing different information called "Support for FIN 48.xls" will cause the
Export Attachment functionality available in the UTP App to not function properly
since this functionality is based on the name of the file

Reply to Posts
· Click the yellow note icon or choose Documentation from an item's menu to Reply to previously

created posts or create a New Post for the item.

 

Edit/Delete Documentation
· Documentation added to a position can not be edited or deleted.
· Any changes which need to be made should be appended as a reply to a previous post.

View Documentation
· Click the yellow note icon or choose Documentation from an item's menu to view the notes &/or

attachments on a position.
· Posts are listed by Post Date with the most recent posts or replies at the top of the list.
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Labels
For single position assignments, click the gray or blue symbol next to the Item's name.  The symbol
next to the Item's name will be gray if no labels have been assigned to it.  A blue symbol indicates
that the Item has labels assigned to it.  Mouse over the blue symbol to view the labels which have
been assigned to the position.

Create New Label
· Enter new label name next to "Create New Label" > click Create
· Note: The preferred format for Label Names is: Label_Name

· Use the underscore "_" rather than create a label which contains a space.

Assign Labels
· Select the labels you wish to assign to the position while holding down CTRL and click Submit

Label Assignment

Unassign Labels
· Hold down CTRL while clicking on the labels you wish to unassign and click Submit Label

Assignment.

View Options
Positions in the Contingencies Table can be viewed in multiple ways depending on what you are
trying to achieve.

Filter
The positions in the Contingencies Table can be filtered to view only the positions you wish to work
with.  The filter is located at the bottom right of the Contingencies table.

Create a Filter
· Begin typing your filter in the box

· The filter should begin with the name of the column header you wish to filter by
· Available options: Code, Name, Jurisdiction, Year, Classification, Status, Resolution Year,

Expiration Year and Label
· As you type, filter options will appear for you to choose

· Equal to, Not equal to, Less than, Greater than
· Click on the filter option you want and possible values to filter on will now appear for you to

choose
· Click on the completed filter you want

· Click Create Filter

*To view all available filter options (without possible values):
· In Firefox: Click in the filter box and press the down arrow or the Backspace key.  
· In Internet Explorer: Click on the dropdown menu arrow in the filter box
You can then click the filter option you want from the dropdown which appears and choose the
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value for the filter.

Current Filters
· After you add a filter, it will be added to the Current Filters dropdown

· A number displays next to Current Filters to show how many filters are currently active

Remove a Filter
· Click on the arrow to the right of Current Filters
· Click on the filter you wish to remove
· To remove all filters click Clear All

Note: The number of rows in the table (lower left corner) updates based on your filter(s).

Sort
Any of the columns in the Contingencies Table can be sorted ascending or descending by clicking
on the Column heading.  The column will sort ascending if the heading is clicked once and
descending if the heading is clicked twice.

Preferences
· Click on the Main Contingency Menu dropdown
· Click Preferences

You can highlight positions in the Contingencies Table which are expiring within the dataset year.
· Check the box to highlight the positions, choose a color to highlight the positions in and click 

Save

Your preferences are stored in a cookie, so if you clear your browser's cookies your settings will revert
to the default.  (No highlighting)

Reorder Columns
The order of the columns in the Contingencies Table can be changed depending on your
preferences.  Click on the column heading for the column you wish to move and drag and drop the
column to a new location along the heading bar.  The column you have selected will be moved to
your newly selected destination.

Batch Print Reports
· Click on the Main Contingency Menu dropdown
· Click Batch Print. The Batch Print Reports popup box will appear in the center of the screen.
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· Select:
· Print Options:

· The desired output (PDF or XLS)
· If the files should be compressed

· Selecting this option will generate a separate file for each report selected, and return
them in a compressed zip file.

· If not selected, a single report file will be returned, with each report on a separate page
(or pages).

· Report Options
·  Filters for the reports you will be printing (same filters as when you choose to view a report

in the Reporting section)
· Report Selection

· Select the report(s) you wish to print
· After selecting the report(s) you want to print, click the + to the left of the report name to

see the available options for each report
· Make your selections about each of the reports you want to print (ex: Payable Report

options below)
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· Once you have made your selections, click Print

Import
· Click on the Main Contingency Menu dropdown
· Click Import
· Browse for the file you wish to import, click Open and then Import.
· If the import is successful you will see a yellow Import Status box

· Click Done to return to the UTP App
· If the import is not successful you will see a red Import Status and will be told where errors

occurred in the file
· Click View Errors to view more detail about the errors in your import file
· Correct your import template and then click Re-Import to import the corrected file

Note: Component > Unit assignment is now being enforced on import.  Make sure you have
assigned your components (categories) to your units in order to avoid errors on import.

Import Template
The UTP App Import Template spreadsheet allows the user to use an Excel spreadsheet template to
populate or update multiple entries in the UTP App.

Note:  A new Import Template is being used in UTP App version 4.0!  Go to the My TaxStream page
in the UTP App to download the new Import Template.

Import Spreadsheet Overview
· The import will begin reading the sheets in the workbook starting on row 3 and proceeding

downward and will stop once it reaches a blank cell in column A.
· Rows 1 & 2 are reserved for headings and descriptions.

· For each row entered, be sure all the corresponding columns with a header are completed to
ensure the spreadsheet is imported correctly.

· If a duplicate row is found, all matching rows will fail on the import.  View Errors will provide you
with more information regarding which position was duplicated so you can easily fix the issue.

· Keep in mind that the codes and other entries are case sensitive!
· Enter all tax rates as decimals - up to 4 decimal places
· Enter probability percentages as whole numbers without the % sign
· Make sure all cells in Excel are formatted as Text
· The Import Template is an Excel file with four sheets that populate the following areas of the

software:
§ #FIN48#: Core Data about the issue
§ #FIN48_OTHER#: Other Data about the issue
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§ #FIN48_LIKELIHOOD#: Probability Table for issues
§ #FIN48_CUSTOM#: Custom Rate Table for issues

· Once your information is entered into the Spreadsheet, you are ready to import the Template into
the UTP App

· For detailed information about the columns in the spreadsheet go to the My TaxStream page in
the UTP App.  There is a UTP App Import Template Guide.  The guide includes a macro which can
convert your existing spreadsheets to the new spreadsheet needed for use in Version 4.0 of the
UTP App.

Import Tips
Creating a "Duplicate" Position
The first seven columns of each sheet of the Import Template represent the defining characteristics
of a position.
· Dataset Year

· This column does not impact any calculations or determinations of Current/Non-Current
status in the UTP App.  You can use this column to create duplicate positions. (blue lines in
below screenshot)

· Classification
· This column does not impact any calculations in the UTP App.  You can use this column to

create duplicate positions. (purple lines in below screenshot)

Export
· Click on the Main Contingency Menu dropdown
· Click Export

· Click Export UTP Items
· This will export all the UTP items in the dataset for which the current user has access to (i.

e. Only items in units assigned to the user will export.)
· The items will export in the Import Template format.
· When you need to update several different positions, using this feature is a helpful and

manageable way to accomplish this.
· Once you have made your changes, you will need to re-import the spreadsheet into the

UTP App.
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· Click Summary under Export Categories to Enterprise
· This will export the categories needed in Enterprise for the Summary Numbers export. 

This categories export is not dataset or unit specific.
· Click Summary under Export Numbers to Enterprise

· This will export the after-tax & after-benefit amounts you will need to represent FIN 48 in
your Provision.  Amounts are exported for all active units in the current dataset you are in.
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Reporting

Main Reports
Uncertain Deferred Rollforward
· Displays the Deferred Tax Asset/Liability balances on an item by Item basis at the beginning and

ending of the period for all the FIN 48 temporary difference items entered.  It can be expanded to
show the various components that increased or decreased the balances during the period.

Deferred with Future Benefit*
· Displays the Deferred Tax Asset/Liability balances (for temporary differences) along with the

Benefit amounts accrued on Current Tax and  Interest at the beginning and ending of the period
for all the FIN 48 items entered.  It can be expanded to show the various components that
increased or decreased the balances during the period.

Uncertain Payable Rollforward
· Displays the Taxes Payable balances on an item by item basis at the beginning and ending of the

period for all the FIN 48 items entered.  It can be expanded to show the various components that
increased or decreased the balances during the period.

Tabular Payable Rollforward
· Displays the ¶ 21(a) Disclosure report required that summarizes the Uncertain Tax Benefit

beginning balance, additions based on tax positions related to the current year, additions for tax
positions of prior years, reductions for tax positions of prior years, settlements and the ending
balance.

Uncertain Journal Entry
· Displays a summary of the journal entries required to be booked for activity during the period.  The

report is broken out by Federal and State entries.  

Uncertain Expense Report
· Displays the Current & Deferred Tax Expense generated on an item by item basis during the

period for all the FIN 48 items entered.  It can be expanded to show the various components that
increased or decreased the balances during the period.

Item Inventory Report 
· Displays the summary of key data for the issues at the end of the period.  It will list the pre-tax

amount in question, the amount expected to be sustained and all the other tax components to
arrive at the ending Uncertain Tax Benefit as well as the other tax adjustments, interest &
penalties. 
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Item Documentation Report
· Displays items along with their notes &/or attachments.

UTP Open Years & Jurisdictions
· Displays the ¶ 21(e) Disclosure report required that summarizes the open positions by year by

major jurisdiction.  When Expanded it shows the issues for the given year and jurisdiction with a
count and the ending payable balance.

*Will be available in the next release  - Version 4.1

Explanations
Current/Non-Current Designation
· Uncertain Payable Rollforward & Payable Sections of Uncertain Journal Entry

· Current/Non-Current designation is determined by comparing the Dataset Period/Year with
the Resolved Quarter/Year of the position.

· If the difference of these time periods is within 12 months: Current
· If the difference of these time periods is greater than 12 months: Non-Current

· Non-Cash Positions are always Non-Current, regardless of the Resolved Quarter/Year.

· Uncertain Deferred Rollforward & Deferred Sections of Uncertain Journal Entry
· Current/Non-Current designation is determined by the Deferred Category selected when

creating the position.

Current Year & Prior Year Columns/Rows
· Deferred (+change), Payable (+change), Tabular Payable, Expense (expanded)

· Compare the Dataset Year with the Position's Year to determine if it will fall into the Current
Year or one of the Prior Year columns.

CTA Calculations
· For information regarding how CTA (Currency Translation Adjustment) is calculated in the UTP

App, please refer to the UTP App CTA Explanation Guide which is located on the My TaxStream
page of the UTP App under UTP Calculations.

Deferred Benefit
· Payable, Tabular Payable, UTP Open Years & Jurisdictions

· Choose Gross/Benefit Option = Gross

View Options
The filters in the Reporting section allow the user to choose how they would like to view each of the
main reports.  If your screen resolution is making it difficult to see the entire filter menu, click the
second icon next to "Reporting" to view the filters vertically, instead of horizontally.

After making your selections (all filters except Label must have a selection in them) click Get Report
to the left of the filters (or below the filters if viewing them vertically) to view the report.
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Currency drop down: If you select USD, CAD, EUR, GBP or JPY as the currency for the unit, the
corresponding symbol will display when viewing reports in the UTP App in Local Currency.

Jurisdiction drop down: If you choose State Specific, the list of States will populate in the same drop
down.  To return to the original drop down, click the top choice in the drop down menu (Non-State
Specific). 

Label drop down: 
· To reset the label selection, click on the green Refresh icon in the drop down menu.
· Label groups are below the dotted line, just as Subconsolidations are below the dotted line in the

Unit / Subconsolidation dropdown menu.

*Deferred with Future Benefit report will be available in the next release  - Version 4.1

Report Specific Views
Show (Payable, Expense, Journal Entry - partial)
· Defaults to all, but if you want to isolate a specific component (tax, other tax adjustment, interest,

penalties, above the line, above the line – interest only, interest + penalties), you can choose to
display a single component.

· On the Payable and Expense reports, the show options are in a dropdown menu.

Detail (Payable, Expense)
· Defaults to hide the detail for each line item, but by clicking show it will display the breakout of

tax, other tax adjustments, interest and penalties and deferred (where applicable).

Group By (Deferred, Payable, Expense, Item Inventory)
· Defaults to none, allows you to format the data to group in numerous ways.  Select your choice

from the dropdown menu.
· Item Inventory defaults to a unit basis.

View (Deferred, Payable)
· Defaults to contracted view showing only Beginning and Ending balances.  The data can show

additional breakout.
· Expand will show the activity during the period summarized by event (change, settlement,

statute expiration, CTA). 
· +change will display additional details about the increases and decrease of the change column. 
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· +cta will display additional details about how the currency translation adjustment effected each
of the events. 

· + both will display the +change and +cta details.

*The selections you are viewing on each report will turn green so you can easily identify the choices
which you have made.

Report View Differences
Certain reports have view options seen only on that report.  These are explained below.

Tabular Payable Rollforward
Show
· When mousing over the above the line and above the line - interest only blue hyperlinks:

· "Without Interest and Penalties" and "Without Interest" will display to offer further
clarification regarding what these views do to the report.

View
· Defaults to contract showing only one column of amounts
· Expand breaks out Tax, Other Tax, Interest, Penalties and CTA all adding up to the Total column

(which is the only column shown in the contract view)
· The CTA column will only have values if Reporting Currency is selected from the Currency

drop down menu.
· Additional rows have been added to further break out CTA on the Tabular Payable

Rollforward.

Uncertain Journal Entry
Show
· Above the Line and Above the Line - Interest Only

· When mousing over these blue hyperlinks:
· "Without Interest and Penalties" and "Without Interest" will display to offer further

clarification regarding what these views do to the report.
· Accrued Interest and Penalties section shows interest and penalties for positions.

· NCS/EQ Detail
· Breaks out Non-Cash and Equity on a Current/Non-Current basis.

· JE Breakout
· Breaks out UTP Payable and Expense into its components: Tax, Interest and Penalties on a

Current/Non-Current basis.

Uncertain Expense
View
· Defaults to contracted view showing only Current and Deferred Columns adding up to the Total

column.  The data can show additional breakout.
· Expanded view shows the detail behind the Current and Deferred sections

· Current Year, PY Increases & Decreases and Statute adding up to Current and Deferred Totals
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*This report will not tie back to the Uncertain Deferred Rollforward and Uncertain Payable
Rollforward reports if you have Equity and/or Non-Cash positions.  This report will tie to the P/L
lines on the Journal Entry report.

· For positions tagged as Equity
· Only the Interest and Penalties amounts for these positions will be seen on the Expense

report
· For positions tagged as Non-Cash

· None of the amounts for these positions will be seen on the Expense report

Item Inventory
Gross/Benefit Option
· Changing the Gross/Benefit Option will not change any of the amounts on this report.

View 
· Defaults to contracted view showing only the position, year, jurisdiction, and associated amounts

for the position.
· Expanded view provides additional information about the position including resolution and

expiration dates and MLTN response.
· Audit view provides additional information including Current & Deferred Tax Benefit and Gross

Interest amounts for positions.
· Audit Detail view provides the interest start and end dates (if entered) for the position as well as

the AIQ current & deferred tax and apportionment rates for the issue.
· Offset view only displays positions which have been marked NCS or EQ and shows the related

information for these positions.

Subtotal
· Defaults to show the subtotals for each of the columns on the report.  Hide will remove the

calculated subtotals for each of the amount columns.

Item Documentation
The Item Documentation report only displays positions which have notes &/or attachments.

Show
· Defaults to notes + attachments showing the positions along with all of their notes and

attachments.
· When Posted By is indented it indicates the note is a reply to a previous note.

· Attachments only shows the position along with a list of the position's attachments.  
· You can click on a filename to open the attachment in the appropriate program.
· You can also batch print all or some of the attachments to a zip file.

· To batch print all of the attachments:
· Put a check in the "select all attachments" box and click Print Selected

· To batch print some of the attachments:
· Put a check next to the attachments you wish to print and click the Print Selected

· If there are duplicate attachments, only 1 copy will print to the zip file
· Notes only shows the position along with all of the position's notes.
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UTP Open Years & Jurisdictions
Group by
· Defaults to jurisdiction, also allows you to format the data to group on a year basis, a

unit/jurisdiction basis, or a unit/year basis.

View
· Defaults to contracted view showing only the jurisdiction and the year for open positions.

· Open positions: positions which have a status of anything other than SET-F, NLU or EXP.
· Expanded view provides additional information about the position including what the position is

and its ending payable.  A subtotal of the number of UTPs and ending payable are also given
based on the ‘group by’ selection.

FIN 48 Disclosure Statements
Classification of Interest & Penalties - ¶ 20
· Annual Disclosure:

· Disclose the policy on classification of interest & penalties relying on in FIN 48 paragraph 19.
· Above or Below the Line

· TaxStream Solution:
· Report views to view effect of classification

· Below the Line -- All or Interest + Penalties
· Above the Line -- Above the Line or Above the Line - Interest Only

Tabular Payable Rollforward - ¶ 21(a)
· Annual Disclosure:

· Tabular Rollforward of unrecognized tax benefits (“UTBs”) at beginning and end of period
· TaxStream Solution:

· Tabular Payable Rollforward Report using the Gross/Benefit Option = "Gross" view
· Can view Above or Below the line

Effect of Issues on the Effective Tax Rate - ¶ 21(b)
· Annual Disclosure:

· Total amount of UTBs that, if recognized, would affect the effective tax rate
· TaxStream Solution:

· Uncertain Journal Entry Report - Change column for the Current and Deferred Provision OR
Uncertain Expense Report "Total Impact to ETR" column

· Export these amounts to FAS 109 to view effect on the overall Effective Tax Rate.

Interest & Penalties - ¶ 21(c)
· Annual Disclosure:

· Total amount of interest and penalties recognized in the income statement and balance sheet
· TaxStream Solution:

· Uncertain Payable Report using the Show = "interest + penalties” view

Issues expected to significantly change in 12 months - ¶ 21(d)
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· Annual Disclosure:
· Positions where it is reasonably possible that the total amounts of the UTBs will significantly

increase or decrease within 1 year of reporting date (¶ 21(d))
· TaxStream Solution:

· Contingencies Table with additional analysis by user to determine nature of uncertainty,
nature of events that would cause a change and estimate of range of change

· Can label items “21d” and filter on them in Contingencies Table or Main Reports to view total
impact

Years with issues remaining open by Jurisdiction - ¶ 21(e)
· Annual Disclosure:

· Description of tax years that remain subject to examination by major jurisdiction
· TaxStream Solution:

· UTP Open Years and Jurisdiction Report

Report Footnotes
Seven of the main reports now contain a Report Footnote section in order to allow you to complete
your entire disclosure in one place.  Report Footnotes are dataset/unit specific and do not rollover at
this time.  If you print out a report that contains a footnote to PDF, the footnote will print on the
page after the report.

Add a Report Footnote
· Click in the Report Footnote box and type your message
· When you are done click Save Footnote

Edit a Report Footnote
· Click in the Report Footnote box and make your changes
· When you are done click Save Footnote

Delete a Report Footnote
· Select all the text in the Report Footnote box and delete it

· It should say "Using 0 of 4,000 characters." under the Report Footnote box
· Click Save Footnote
· Click OK when asked "Are you sure you want to delete this footnote?"

Printing
On each of the Main Reports there is the ability to export the report to a PDF or XLS file.  To choose
where to print your report to, right click by the report heading:
· Click Export to PDF to export the current report to Adobe.  Click Open or OK when prompted.

· Click Export to XLS to export the current report to Excel.  Click Open or OK when prompted.

We highly recommend not printing any of the reports from your browser's Print menu.  All of the
reports have been formatted to print to PDF and XLS, and this formatting may not always carry over
when the report is printed directly from the browser.  If you wish to print a report out, choose the 
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Export to PDF or XLS option on the report.

Note:  This functionality is not available in Internet Explorer 6.0.  In order to use this functionality,
you will need to upgrade your browser to Internet Explorer 7.0 or Mozilla Firefox 2.0+.  If you are
unable to install one of these browsers, simply use the Batch Print Reports option in the Uncertain
Positions section to print out the reports to PDF or XLS or download the executable desktop
application from the My TaxStream section of the UTP App.

Interim Reporting and FIN 48
Best practices for Interim Reporting and FIN 48.

Best Practice
Dataset Structure
· Quarterly datasets are the recommended dataset structure for your Interim Reporting

requirements.  This will allow for each quarter of discrete activity to be isolated.
· To view your entire year (or year to date) of FIN 48 activity, use the Dataset Merge functionality.

Interest as part of Effective Tax Rate
· If you view interest as being part of your Effective Tax Rate, rather than as a Discrete Item, you can

use the "Above the Line - Interest Only" show option on reports to arrive at the total Discrete
impact of your FIN 48 items.

Enterprise Interim Tab
· If  you view all FIN 48 activity as Discrete, you can use the Export Numbers to Enterprise feature to

extract your FIN 48 data from the UTP App.
· Import this file into the Actual section of the Interim tab for the appropriate time period.



SOURCE UTP App User Manual

© 2009 TaxStream

ONE  

Terminology
Tax Position
· Income or expense item where the book treatment differs from the treatment by the taxing

authorities.

Recognition (FIN 48 Step 1)
· Identification of potential tax positions that are not expected to be provided for on the

return/provision.  Once identified, the tax position is subjected to the more likely than not
threshold standard.  Positions with a greater than 50% likelihood of being sustained under audit
should then move to FIN 48’s second step: Measurement.

Measurement (FIN 48 Step 2)
· Once a tax position is determined to be Recognized from Step 1, then the appropriate amount is

determined using a probability analysis.

Probability Analysis
· Analysis on all non-highly certain issues (e.g. permanent or tax adjustments) to quantify the

amount that is expected not to be sustained if the position was lost on audit.

Highly Certain Tax Positions
· Tax positions where the law is clear and unambiguous as to the deduction that would be

sustained, but where the timing of the item might have some room for interpretation.  Highly
certain positions are considered to be 100% probable for recognition purposes.

Uncertain Tax Position “UTP”
· The difference between the position taken, or expected to be taken, on a tax return and the

potential amount that is expected to be sustained after audit or through litigation.

As Filed Basis
· The position as it was or as it is expected to be on a tax return.

FIN 48 Basis
· The additional exposure on potentially auditable issues or the UTP, that would exceed the amount

provided on an As Filed Basis.

Financial Basis
· The combination of the As Filed Basis positions and the FIN 48 positions ensuring that all issues

are fully accrued for in the payable account.

Interest & Penalties
· Accrual for the potential exposure of interest and penalties for an Uncertain Tax Position.
· An accounting policy election determines whether the expense for the interest & penalties should

be treated as an interest expense or penalties expense (above the line) or both should be treated
as income tax expense (below the line).
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Hot Interest
· Underpayments of over $100,000 are subjected to a "hot" interest rate that is 2% higher than the

normal underpayment rate.

Overpayment
· C Corporations which have refunds in excess of $10,000 are subjected to "GATT" refund rates. 

The "GATT" refund rate applies to the portion of the refund in excess of $10,000.

Change in Judgment/Return to Provision Adjustment
· Previously provided FIN 48 item can change in future periods.  Items often need to be adjusted if

there is an announcement of a change in statutory rate, if there is a legislation release or once the
return to provision adjustments are finalized for a year.

Expiration of Statute
· Once the Statute of Limitations on the issue expires and the position is determined unavailable for

audit, the position no longer needs to be provided for under FIN 48.

No Longer Uncertain
· When it is determined that you no longer need to provide for a tax position on a FIN 48 basis since

it is no longer uncertain.

Full Settlement
· When an issue has gone through the auditing process and a settlement is reached, the amount of

the settlement is recorded and any remaining balances are considered no longer necessary.

Partial Settlement
· When an issue has gone through the auditing process and a settlement is reached on a portion of

a position, the amount of the settlement is recorded and the remaining balance continues to be
uncertain.

Deferred Benefit
· Tax and Interest benefit is viewed as being a component of Deferred Expense and Deferred Tax

Assets, rather than Current Expense and Current Payable.

CTA (Currency Translation Adjustment)
· The interplay of the Weighted Average and Spot rates may require that a currency translation

adjustment be posted to account for the difference in the rates.
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FIN 48 in the Provision
The following is an overview of how the FIN 48 Uncertain Tax Positions and the FAS 109 Tax
Provision interact.
FIN 48 in FAS 109

“As Filed” (FAS 109) Data
The As Filed Basis datasets should be populated with the provision information that is expected to
be ultimately reported on a tax return.

· Pre tax book income
· Current & deferred tax rates
· Permanent differences
· Temporary differences
· After tax temporary differences
· Tax adjustments
· State information

FIN 48 Data
The FIN 48 datasets should be populated with the effect of the uncertain tax positions populated in
the UTP App.  The FIN 48 amounts are entered on an after tax basis for both Federal and State UTP
amounts.
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TaxStream Enterprise Provision
Typically, a summary approach is used when viewing your FIN 48 information in TaxStream
Enterprise.  There are 2 different options you can use to migrate your FIN 48 information from the
UTP App to TaxStream Enterprise.

Manual Approach
In the UTP App, go to the Uncertain Journal Entry report and record the following amounts from the
Change column.  (Be sure to choose the correct show option based on your treatment of interest
and penalties!)

· Federal:
· Payable

· P/L: Provision for Current Income Taxes
· B/S: Non-Cash Offset
· EQ: Equity Offset

· Deferred
· P/L: Provision for Deferred Income Taxes
· B/S: Non-Cash Offset
· EQ: Equity Offset

· States:
· Payable

· P/L: Provision for Current Income Taxes
· B/S: Non-Cash Offset
· EQ: Equity Offset

· Deferred
· P/L: Provision for Deferred Income Taxes
· B/S: Non-Cash Offset
· EQ: Equity Offset

In Enterprise or Online, in your Provision dataset or a copy of your Provision dataset, create line
items for these amounts to determine the impact of your UTPs on your provision and your effective
tax rate.

· Provision for Current Tax Amounts:
· Non Cash Federal Tax Adjustment (NC_)
· Non Cash State Tax Adjustment (NC_)

· Provision for Deferred Tax Amounts:
· Federal After Tax Temporary Difference – Deferred Only Adjustment
· State After Tax Temporary Difference – Deferred Only Adjustment

· Non-Cash Offset & Equity Offset Amounts:
· Federal After Tax Temporary Difference - Balance Sheet Only Adjustments
· State After Tax Temporary Difference - Balance Sheet Only Adjustments
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Export Approach
In the UTP App:

· Export Summary Categories and Numbers for the dataset you are working with.  The Numbers
export will tie directly back to the Uncertain Journal Entry report.

· Import the Summary Categories into Enterprise.
· Import the Summary Numbers into Enterprise.

· The dataset you import this into depends upon your process for FIN 48.  You may be using
your Provision Dataset, a copy of your Provision Dataset, or a dataset designated
specifically for your FIN 48 items.

· If you are using a dataset designated specifically for your FIN 48 items, create a Reporting
Dataset containing your Provision Dataset and your FIN 48 Dataset.

· View your Federal & State Tax Provision Reports, the Effective Tax Report, and Deferred
Balances Report to see the affect of FIN 48 on your provision.
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Frequently Asked Questions
Frequently Asked Questions about the UTP App.

General Usage
1.  What do I do if I’m trying to add a new position and the Uncertain Tax Position dropdown just
keeps displaying “Loading?”

Answer:  You have probably not assigned your categories to the unit you are in.  See
Unit-Component Assignments.

2.  I use Internet Explorer 6.0 and I tried to export a report to PDF/XLS and it's not working.  What
can I do?

Answer:  This functionality is not available in Internet Explorer 6.0.  We highly recommend that
you use Mozilla Firefox 3 when using the UTP App.  Downloading the Desktop App or Internet
Explorer 7.0 are other viable options.

3.  When I click Dataset Merge, I get the message: "The current dataset is not a member of any
reporting datasets eligible for merging."

Answer:  There are two different reasons you may receive this error message.  
· You may not have created a sequential reporting dataset which is required for the dataset

merge.  This is done on the Provision side.  Please refer to the instructions on the bottom
of the Quick Links page for more information.

· If you have already created a sequential reporting dataset, you are receiving this message
because the dataset you are in is not a member of the reporting dataset.  Click Settings,
choose a dataset which is a part of the reporting dataset, and click Save.

4.  Some of the positions on my reports are displaying without an Item Description and I can't
delete them.  What happened?

Answer:  A user deleted one or more categories (perm, temp, tax adj) which were associated with
a UTP.  Please contact Support to have this issue resolved.  (Deleting categories which are in use
will not be possible when using the Admin Center: Components to manage your categories
instead of the Provision side.)

5.  How do I enter a Partial Settlement?
Answer:  Built in functionality for Partial Settlements is now available.  For how the new
Settlement workflow works please refer to the UTP App Settlement Guide which is located on
the My TaxStream page of the UTP App under UTP Guides.  The guide should be reviewed
before attempting to settle positions using the workflow.  If a mistake is made, see question 7
below.

6.  Where can I get a breakdown of the interest calculation by year?  (Only applicable when using
TimeValue TaxInterest to calculate interest)

Answer:  The Interest & Penalties schedule breaks down the interest calculation by quarter.  You
can export this schedule to Excel and modify it to achieve the breakdown you are looking for.  
(You will need to Convert Text to Columns to isolate the Interest amount.  

· Select the rows the interest information is in and remove the "Merge and Center" option.
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· Select  the interest information.
· Data > Text to Columns > choose Delimited > click Next > put a check in Space > click

Finish)

7.  What do I do if I made a final modification (EXP, NLU or SET-F) on a position by mistake?  What
do I do if I partially settled (SET-NF) a position incorrectly/by mistake?

Answer:  A new dataset will need to be created to fix the position(s).  If you have already made
several changes in the current dataset, you can:

· Export out the current dataset (Export UTP Items) and save the file
· Re-roll the previous dataset to a new dataset
· Make necessary modifications to the exported file (change the incorrectly modified

position(s)!)
· Import the file into the new dataset you created

8.  Which states/provinces do not have their own rate tables?
Answer:  States/Provinces without their own rate table are defaulted to Federal/Canada.  For a
complete list, please refer to State and International Positions.

Import
1.  If I make a change to one of the first 7 columns of data (columns A through G) and import it into
the UTP App a new position is added.  Why?

Answer:  Making a change to one of the first 7 columns creates a new position because you are
changing one of the defining characteristics of the position.  If you wish to create a duplicate
position (same code, jurisdiction, year) please refer to Import Tips.

2.  Can custom interest tables be imported into the UTP App?
Answer:  The ability to import custom interest tables is now available.  For more information,
please refer to the Import Template Guide (slides 14-15) which is located on the My TaxStream
page of the UTP App under UTP Guides.

3.  Can settlements (Full or Partial) be imported into the UTP App?
Answer:  No.  The workflow must be used to enter Full and Partial Settlements.

Technical
1.  What is the preferred browser for using the UTP App?

Answer: We highly recommend that you use Mozilla Firefox 3 (or download the "Desktop App").
Internet Explorer 7.0 is also a viable option.

2.  What do I need to do to get the latest version of the UTP App?
Answer:  If you use www2.taxstreampro.com/corp to access the UTP App, you have the latest
version of the UTP App.  If this is not how you access the UTP App, please contact your
Administrator for more information on your update schedule.

https://www2.taxstreampro.com/corp
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